


Računalstvo
5. Obrada teksta - MS Word
5.1. Obrada teksta u Microsoft Wordu – osnovni pojmovi

5.1.1. Uvod u obradu teksta
-obrada teksta omogućena je pojavom programa koje zovemo obrađivači teksta (tekstni procesori, engl. text processor)
-najčešće korišteni takav program je Microsoft Word, kraće – MS Word ili samo – Word
-on je dio programskog paketa Microsoft Office  - kraće MS Office ili samo – Office
-mi obrađujemo Word 2019 iz paketa Office 2019
-Word služi za složeniji rad s tekstom i ostalim objektima (obrada teksta, engl. text processing) dok za jednostavne preinake na čistom tekstu služe uređivači teksta (editori teksta, engl. text editor, npr. Blok za pisanje)
-sadržaj stvoren u Wordu možemo spremiti u više raznih vrsta datoteka, a takvu datoteku zovemo dokumentom (engl. document)
-sufiksi tih datoteka su:
· [image: ]docx
-ovo je dokument spremljen u uobičajenom obliku
-on podržava sve naredbe i objekte dostupne u Wordu
[image: ]-ako ništa ne želimo mijenjati, Word automatski sprema sadržaj u taj format
· doc
-to je dokument spremljen u starijim verzijama Worda, do verzije 2003
-stariji format dokumenta ne podržava direktno (radi se pretvorba) sve naredbe i objekte dostupne u Wordu pa program često pri spremanju iz novoga u stari oblik dokumenta traži pristanak korisnika za potrebne pretvorbe
-neki složeniji objekti ne mogu se spremiti iz novijega formata u stari
-koristimo ga ukoliko netko nema noviju verziju Worda ili ne želimo promijeniti izgled dokumenta spremljenog u starom formatu datoteke
-ukoliko otvaramo stariji format, Word traži da kliknemo gumb koji će omogućiti preinake u tekstu
· pdf
-u nekoliko zadnjih verzija podržano je spremanje u ovaj univerzalni format za razmjenu datoteka
-pretvaranje u ovaj oblik koristimo ako želimo poslati nekome dokument, a on ne koristi Word ili prije ispisa na većim formatima (npr. želimo ispisati plakat formata A1)
-možemo i otvoriti postojeću PDF datoteku za uređivanje sadržaja, ali pritom ju prvo moramo pretvoriti u docx format
-pri tom pretvaranju često se dogodi da Word ne zna ispravno prepoznati složeniji dio sadržaja (npr. tablice ili crteže) pa te dijelove pretvori u sliku čiji sadržaj ne možemo uređivati
-u tom slučaju neprepoznate dijelove datoteke moramo ručno unijeti
· xml
-ovo je format u obliku web stanice
-rijetko ga upotrebljavamo, osim za dodavanje sadržaja na web stranice
· txt
-ovakav oblik datoteke zadržava samo tekst bez opcija oblikovanja (npr. podebljanje, boja fonta, efekti teksta)
-taj oblik identičan je onome Bloka za pisanje
-koristimo ga ponekad ako nam je bitan samo sadržaj (npr. serijski brojevi računalne opreme)
-programi za obradu teksta namijenjeni su za: 
· uređivanje teksta i ostalih sadržaja
· oblikovanje teksta i ostalih sadržaja
· ispisivanje teksta i ostalih sadržaja
-omogućavaju brzo i lako pisanje teksta, ispravljanje, oblikovanje, pretraživanje, ispis, umnožavanje, unos slika, organiziranje podataka u tablice te još puno toga 
-svaku datoteku koju stvorimo Wordom nazivamo dokumentom
-dokument se sastoji od niza stranica (engl. page) koje se (za razliku od onih u knjigama) tipično nalaze jedna ispod druge, a ne jedna pokraj druge
-rubovi stranica dokumenata zovu se margine (engl. margin) i ne služe za upis teksta, već dodatnog sadržaja (npr. broja stranice, engl. page number)
-osnovni dio teksta u dokumentu zovemo odlomak (engl. paragraph), a prepoznajemo ga po tome što završava (i počinje) pritiskom na tipku Enter (krajevi odlomka su i početak i kraj dokumenta)
-odlomak u Wordu odgovara po smislu odlomku u knjizi
-pismom (engl. font) nazivamo određenu vrstu izgleda znakova koje koristimo u dokumentu
-fontovi su definirani vrstom (tipom), veličinom, bojom i posebnim svojstvima (npr. podebljanjem)
-pokazivač (kursor, engl. cursor) je trepćuća crtica koja pokazuje trenutno mjesto upisa teksta
-ukoliko je redak teksta dulji od širine radnog područja, program će ga automatski prebaciti u novi red, čim tekst dotakne desni rub radnog područja
-program Word pokrećemo:
· dvoklikom ikone programa (uobičajeno)
· dvoklikom na neku njegovu datoteku
· odabirom imena programa iz popisa instaliranih programa
-trenutno otvoreni dokument u Wordu se zatvara odabirom naredbe Datoteka>Zatvori (engl. File>Close) ili klikom na gumb prozora za zatvaranje (bijeli x u crvenom kvadratiću)
5.1.2. Opis prozora u programu
-tipičan izgled prozora u Wordu 2019 prikazan je idućom slikom
[image: ]






-prozor Worda sastoji se od ovih dijelova:
1. vrpce s naslovom (naslovne trake, engl. Title bar)
-na njoj piše naziv programa s kojim radimo (Word) i naziv datoteke u kojoj trenutno radimo
-osim toga, na kraju vrpce se nalaze gumbi za minimiziranje, sažimanje (ili maksimiziranje) i zatvaranje programa
-ukoliko datoteci nismo dodijelili neko ime, Word joj automatski daje naziv Dokumentn, gdje je n broj nespremljenog dokumenta (npr. Dokument1, Dokument2, ...)
2. alatne trake za brzi pristup (engl. Quick Access Toolbar)
-ovdje se nalazi nekoliko često korištenih naredbi (npr. Spremi, Poništi upis, Ponovi upis)
[image: ]-na tu traku možemo dodati još više naredbi ili maknuti postojeće (klikom na krajnje desni simbol trokutića) 
-nije preporučljivo prepuniti traku jer postaje nepregledna i time manje upotrebljiva
3. vrpca (engl. Ribbon) s karticama i naredbama za rad u dokumentu
-to su vrpce koje u sebi sadrže ikone nekih od često korištenih naredbi
-postavi li se pokazivač miša iznad neke od ikona u vrpci, pojavi se okvirić s kratkim opisom naredbe koju ta ikona predstavlja
-sadržaj vrpce vidi se odabirom odgovarajuće kartice (npr. Polazno)
4. kartica (engl. Tabs)
-tu se nalaze gumbi grupa naredbi (npr. Dizajn, Raspored) iz kojih možemo odabrati željene naredbe pomoću lijeve tipke miša ili pritiskom na tipku Alt i izborom slova u okviriću oko gumba (npr. tipka Alt i slovo D otvaraju karticu Datoteka)
5. grupa naredbi (engl. Group)
-to je naziv za više češće korištenih naredbi na otvorenoj vrpci, a grupiranih po nekom kriteriju sličnosti (npr. u grupi Font su prikazane ikone nekih češćih naredbi za promjenu izgleda pisma)
6. pokretača dijaloškog okvira (engl. Dialog Box Launcher)
[image: ]-klikom na sitni kvadratić sa strelicom otvara se prozor sa svim dostupnim naredbama u nekoj grupi naredbi (npr. klikom na taj kvadratić pokraj grupe Odlomak otvara se prozor sa svim naredbama kojima možemo oblikovati odlomak) 
7. ravnala (engl. Ruler) po horizontali i vertikali
-ravnala nam prikazuju udaljenost od početka stranice (gornji lijevi kut prozora) u cm ili mm te nam omogućuju orijentaciju na stranici (odnose veličina pojedinih dijelova stranice)
[image: ]-na horizontalnom ravnalu možemo namještati oznake za uvlačenje teksta (bitno za oblikovanje odlomaka na stranici)
-bijeli dio ravnala označava mjere na radnoj površini, a sivi na marginama 
8. radne površine (plohe, područja, engl. Workspace)
-to je najveći dio prozora Worda, a služi nam za unos i obradu nekog sadržaja (većinom teksta) u dokumentu
-možemo birati različite načine prikaza u tom području
9. gumbi za promjenu prikaza dokumenta (engl. View Buttons)
-njima možemo brzo promijeniti prikaz dokumenta
-na raspolaganju su nam Raspored za ispis, Način za čitanje, Raspored za web
-uobičajeno koristimo Raspored za ispis (izgled na ekranu isti je ispisanom)
-Način za čitanje ubrzava i olakšava čitanje, dok je Raspored za web pogodan za prikaz web sadržaja
10. vrpce stanja ili statusne trake (engl. Status bar)
-na njoj se pojavljuju poruke o stanju programa (npr. Word je pronašao jezične pogreške) i informacije o trenutnoj strani, ukupnom broju stranica i jeziku postavljenom u Wordu za jezičnu provjeru i provjeru pravopisa
11. klizača (engl. Scroll bar, Slider) po horizontali i vertikali
-njima se cijeli sadržaj radnog područja pomiče za željeni iznos gore-dolje ili lijevo-desno
-sadržaj pomičemo s ciljem lakšeg nalaženja traženog dijela dokumenta
-kliknuti lijevom tipkom miša možemo na strelice na krajevima klizača, između klizača i strelica na krajevima ili na klizač koji povlačimo u željenom smjeru
-pomicanje na klik je:
· red gore-dolje (klikom na strelicu)
· ekran gore-dolje (klikom između klizača i strelice)
· više stranica gore-dolje (pomicanjem klizača)
-slično, na horizontalnom ravnalu klikovima se pomičemo više ili manje znakova lijevo-desno
-ovisno o količini sadržaja i načinu prikaza vidimo jedno ili oba ravnala
12. gumba zumiranja (engl. Zoom)
-pomicanjem klizača ili klikanjem na + i - biramo brzo veličinu prikaza dokumenta u opsegu od 10 % (10 puta smanjeni prikaz strane, vidi se puno sitnih strana dokumenta) do 500 % (5 puta uvećani prikaz stranice dokumenta, vide se samo pojedina slova)
-iznos zumiranja piše u okviriću desno od znaka +, a klikom iznosa zuma otvaramo dijaloški okvir u kojem možemo dodatno podešavati veličinu prikaza (npr. Širina stranice) 
5.1.3. Kartice (engl. Tabs) u Wordu
-sve naredbe Worda grupirane su u kartice (prije su se slični gumbi zvali izbornici ili meniji (engl. menu)
-otvaranjem neke kartice vidljive su na horizontalnoj traci grupirane (engl. group) neke od češće korištenih naredbi  (i neke dodatne mogućnosti naredbi)  prikazane ikonama
[image: ][image: ]-to nisu sve dostupne naredbe, ali klikom na pojedine dostupne pokretače dijaloških okvira otvaraju se sve dostupne naredbe
-u Wordu postoje ove osnovne kartice:
a) Datoteka (engl. File) 
-njezine naredbe služe za rukovanje datotekama (npr. otvaranje, stvaranje, spremanje), za postavljanje dodatnih mogućnosti programa (npr. zadane lokacije za smještanje dokumenata) i za ispis dokumenta
-odabirom te kartice prikazuju se naredbe u vertikalnom smjeru
b) Polazno (engl. Home)
[image: ]
-ovdje su naredbe kojima se rade preinake u tekstu (npr. brisanje, kopiranje, traženje teksta i sl.) i oblikuju odlomci
-naredbe su svrstane u ove grupe:
· Međuspremnik (engl. Clipboard)
-služi za privremeno pamćenje do 24 kopirane ili izrezane stavke (npr. teksta)
· Font (engl. Font)
-tu mijenjamo osobine pisma (npr. vrsta i veličina pisma)
· Odlomak (engl. Paragraph)
-ovdje su naredbe za oblikovanje odlomka (npr. poravnanje, prored)
· Stilovi (engl. Styles)
-namijenjen je za stvaranje i odabir stilova
· Uređivanje (engl. Editing)
-tu je nekoliko naredbi za uređivanje teksta (npr. traženje, zamjena)
c) Umetanje (engl. Insert)
[image: ]
-kao što sugerira naziv kartice, nekom od naredbi može se u dokument ubaciti neki objekt (npr. slika, posebni znak i sl.)
-sastoji se do ovih grupa naredbi:
· Stranice (engl. Pages)
-ovdje umećemo praznu ili naslovnu stranicu, odnosno kraj stranice
· Tablice (engl. Tables)
-tu su sve naredbe za rad tablicama (npr. Umetni tablicu)
· Ilustracije (engl. Illustrations)
-služi za umetanje grafičkih objekata (npr. slika i crteža)
· Dodaci (engl. Add-ins)
-ovdje možemo instalirati i koristiti neki program kojim dopunjujemo ili poboljšavamo rad Worda (npr. tipkovnicu s emojima)
· Medijski sadržaji (engl. Media)
-koristimo ga za ubacivanje video i zvučnih zapisa (npr. s Youtubea)
· Veze (engl. Links)
-dodajemo linkove i sl. (npr. link na web stranicu Net.hr)
· Komentari (engl. Comments)
-ovim naredbama možemo dodati i uređivati komentare
· Zaglavlje i podnožje (engl. Header & Footer)
-kada nam treba dodati broj stranice i sl. u podnožje ili zaglavlje stranice, biramo ove naredbe
· Tekst (engl. Text)
-želimo li na stranicu dodati posebne tekstne oblike (npr. tekstni okvir), ovo je pravo mjesto za to
· Simboli (engl. Symbols)
-ustrebaju li nam znakovi kojih nema na tipkovnici ili neka formula, odaberemo naredbe iz ove grupe
d) Dizajn (engl. Design)
[image: ]
-ovim naredbama možemo dodatno poboljšati izgled dokumenta (npr. dodavanjem i podešavanjem efekata teksta)
-kartica je podijeljena na:
· Oblikovanje dokumenta (engl. Document Formatting)
-ovdje možemo promijeniti izgled teksta promjenom svojstava pisma ili odabirom drukčijeg stila ili teme (npr. odaberemo temu Faseta)
· Pozadina stranice (engl. Page Background)
-ne želimo li bijelu pozadinu stranice, ovdje ju možemo uokviriti i postaviti nove pozadine (npr. sliku cvijeta kao pozadinu)
e) Raspored (engl. Layout)
[image: ]
-time utječemo na izgled stranice i odnose pojedinih elemenata na njoj (npr. stranica A3 gdje jedna slika djelomično prekriva drugu)
-tri su grupe naredbi:
· Postavljanje stranice (engl. Page Setup)
· Odlomak (engl. Paragraph)
· Rasporedi (engl. Layouts)
-ovdje definiramo odnose objekata (npr. prelamanje teksta)
f) Reference (engl. References)
[image: ]
-ove naredbe pomažu nam snalaženje u dokumentu (npr. umetanjem tablice sadržaja, fusnota, popisa slika,…)
-ima dosta grupa naredbi, ali se rijetko koriste na manjim dokumentima
g) Skupna (cirkularna) pisma (engl. Mailings)
[image: ]
-ovim naredbama stvaramo pisma koja treba slati na puno adresa pri čemu je većina sadržaja ista, a neki dijelovi su individualni (npr. u pismu o promjeni uvjeta neke banke za kredite je sadržaj pisma isti, a mijenja se samo adresa na koju se pisma šalju)
h) Pregled (engl. Review)
[image: ]
-ovim naredbama koristimo se kada radimo provjeru gotovoga dokumenta (npr. provjeravamo da li postoje pravopisne pogreške)
-naredbe su uglavnom namijenjene kada skupina osoba zajedno radi na istom dokumentu (npr. pišu udžbenik iz Računalstva)
i) Prikaz (engl. View)
[image: ]
-tu su naredbe za upravljanje prikazom sadržaja i prozora dokumenta
-glavne grupe naredbi su:
Prikazi (engl. Views)
-ovdje biramo način prikaza dokumenta (npr. većinom koristimo Raspored za ispis)
Pokaži (engl. Show)
-prikazujemo ili skrivamo dodatne elemente (npr. ravnalo, crte rešetke i navigacijsko okno)
Zumiraj (engl. Zoom)
-ovime određujemo veličinu prikaza (npr. Širina stranice)
Prozor (engl. Window)
-kada istodobno radimo s više dokumenata (npr. kopiramo iz jednoga u drugi), možemo si ubrzati rad tako da svaki otvorimo u zasebnom prozoru
j) Pomoć (engl. Help)
[image: ]
-kao što nam sugerira naziv, u ovom izborniku nalaze se naredbe za traženje pomoći kod rada s programom
-ovisno o tome s kakvim objektom radimo, otvaraju se kartice dodatnih alata (npr. kada radimo na tablici ili na slici)
5.1.4. Rad s datotekama 
-stvaranje novog praznog dokumenta najlakše je naredbom Datoteka>Novo (engl. File>New), klikom na ikonu u traci za brzo pokretanje ili prečicom Alt + N (skraćeno od engl. New)
[image: ]-nakon aktiviranja te radnje (bilo kojim načinom) pojavljuje se okno zadataka (mali prozor s desne strane unutar glavnog prozora za pisanje teksta) te nam nudi stvaranje praznog dokumenta ili biranje određenog predloška (engl. template)
-predložak je dokument oblikovan na određeni način tako da su neki elementi već raspoređeni pa ga možemo samo doraditi (npr. predložak za rođendansku čestitku)
-predlošci u Wordu slični su onima koje uobičajeno koristimo u Powerpointu 
-predložak je smisleno koristiti ako manjim njegovim izmjenama dobivamo očekivani izgled dokumenta
-u Wordu je puno dostupnih predložaka raspoređenih u grupe na temelju tematske povezanosti (npr. Letak pozivnice na zabavu), a još više ih možemo pronaći na internetu (npr. na stranicama proizvođača Officea, Microsofta)
[image: ]-bilo koji Wordov dokument možemo koristiti kao predložak za buduće dokumente
-u tom slučaju ne spremamo ga kao klasični Wordov dokument (sufiks .docx) nego kao datoteku predloška (nastavak .dotx)
-uobičajeno ne koristimo predloške nego stvaramo prazan dokument (engl. blank document)
-Word automatski praznoj datoteci daje ime Dokument1 (ako je to prva prazna datoteka) ili isto uz neki drugi broj
[image: ]-poželjno je da se datoteci promijeni ime u neko smisleno, tj. napravi se kopija datoteke kojoj se dodijeli neko željeno ime
[image: ]-u tu svrhu dokument se sprema na izabrano mjesto naredbama Datoteka>Spremi kao (engl. File>Save As)
-pojavit će se prozor Spremi kao (prečica Ctrl + S, engl. Save as)
-možemo birati spremanje (uz izbor novoga imena datoteke) na računalu (opcije Ovo računalo ili Pregledaj) ili na nekoj web usluzi spremanja  u oblaku (npr. OneDrive)
-možemo pogledati i popis nedavno otvaranih datoteka (engl. Recent) i mapa za smještanje
-mape za smještaj datoteka koje često koristimo možemo jednostavno kliknuti mišem i time ih staviti na traku za brzo pokretanje Explorera datoteka
-u prikazu nalik na ono Explorera za datoteke izaberemo disk i mapu (kliknemo lijevom tipku na njezino ime) u koju ćemo spremiti datoteku
-pritom u polje Naziv datoteke (engl. File name) unosimo naziv datoteke (neko smisleno ime), dok sufiks definira polje Spremi u obliku (prečica Ctrl + S, engl. Save as)
-uobičajeno je da u tom polju stoji naziv Word Document što označava da je sufiks datoteke .docx
-može se izabrati i neka druga vrsta formata (npr. txt, doc, pdf, dotx), ali to je uglavnom za neke posebne namjene (npr. spremanje za stariju verziju Worda)
-nakon toga se svako daljnje spremanje bez promjene datoteke obavlja naredbom Spremi (engl. Save) koju možemo pokrenuti iz vrpce (Datoteka>Spremi (engl. File>Save)) ili kliknuti na ikonu na traci za brzo pokretanje
-Word sam automatski sprema sadržaj nakon određenog vremena (obično je to 5 minuta), ako je tako podešeno u opcijama programa
-ponekad je vrlo nezgodno tako često spremanje sadržaja (pogotovo radimo li s velikim datotekama, npr. datoteka s velikim slikama) pa se ta opcija može isključiti te se spremanje obavlja ručno
-u tom slučaju poželjno je spremanje barem svakih 15 minuta da ne bi došlo do gubitka svega unesenoga u datoteku nakon zadnjeg spremanja sadržaja (npr. zbog neispravnog rada Worda ili Windowsa – blokiranja programa)
-u Wordu je čest slučaj da istodobno imamo otvoreno nekoliko dokumenata (npr. iz jedne datoteke kopiramo dio teksta u drugu)
[image: ]-promjenu trenutno otvorene datoteke (aktivne) vršimo najjednostavnije klikom lijevom tipkom na ikonu programa i odabirom željene datoteke u vrpci zadataka
-trenutno prikazana otvorena datoteka prikazana je u tamnijem okviru 
[image: ]-manje efikasan (i rijetko korišten) način za promjenu trenutno prikazane otvorene datoteke je pomoću kartice Prikaz na kojoj odabiremo naredbu Promjena prozora 
-sve datoteke koje su otvorene prikazane su na spisku, a ona koja je aktivna (prikazana) označena je kvačicom
-aktivnu datoteku mijenjamo lijevim klikom na ime datoteke, a pritom se kvačica premjesti uz ime te datoteke
-datoteku zatvaramo naredbom Datoteka>Zatvori (engl. File>Close)
-ukoliko prije toga nismo spremili zadnju promjenu u datoteci, Word nas pita želimo li to učiniti ili ne
-datoteku u općem slučaju otvaramo naredbom Datoteka>Otvori (engl. File>Open), prečicom Ctrl + O (od engl. Open) ili klikom na neku Wordovu datoteku ako Word nije pokrenut
[image: ]
-poslije toga otvara se prozor identičan onom naredbe Spremi kao s popisom diskova, mapa i datoteka iz kojeg biramo datoteku u nekoj od mapa te kliknemo lijevom tipkom miša na gumb Otvori (engl. Open) 
-datoteke koje su bile posljednje otvorene stavljene su na spisak prve
-na dnu popisa mapa nalazi se gumb Oporavi dokumente koji nisu spremljeni (engl. Recovery unsaved documents)
-ta naredba je korisna ako je došlo do prestanka rada Worda, a nismo spremili sve promjene
-čak i slučaju rušenja Worda često Word uspije spremiti promjene, ali datoteka nema ispravni naziv
-tada ovom naredbom vraćamo takvu datoteku u željeno stanje
-u kartici Datoteka još postoje naredbe:
a) Informacije (engl. Info)
-ovom naredbom dobijemo detaljne podatke o dokumentu i njegovu statistiku (npr. kako dugo je rađeno na njemu, koliko je strana i koliko znakova i sl.)
-možemo kliknuti i jedan od tri gumba:
· Zaštiti dokument (engl. Protect Document)
-ovdje zadajemo kakva prava na izmjene u dokumentu ima netko kome pošaljemo datoteku
-uobičajeno ima sve ovlasti, ali možemo ih i ograničiti  (npr. da može samo čitati i ispisivati, ne i mijenjati sadržaj ili oblikovanja)
-da netko nepozvan ne bi znao sadržaj datoteke, ovdje ju možemo zaštiti i lozinkom koju će onda trebati unijeti za svako otvaranje datoteke
· Provjeri ima li problema (engl. Check for Issues)
-ovom naredbom provjeravamo da li:
su u dokumentu vidljivi neki osobni podaci (npr. da li se vidi ime autora dokumenta)
osobe s poteškoćama imaju problema pri pregledavanju sadržaja (npr. da li ga lako može koristiti slabovidna osoba)
je dokument kompatibilan sa nekim starijim verzijama (npr. da li će se pri spremanju u neku verziju izgubiti neki dio sadržaja)
· Upravljanje dokumentom (engl. Manage Document)
-ovdje možemo vidjeti popis dokumenata koje smo zatvorili bez spremanja i probati vratiti njihov sadržaj (ako je to potrebno)
[image: ]
b) Ispis (prečica Ctrl + P, engl. Print)
-ovdje otvaramo prozor za podešavanje ispisa dokumenta
-u njemu možemo vidjeti kako izgleda sadržaj koji ćemo ispisivati i zumirati ga na
[image: ]
-za ispis zadajemo:
· postavke ispisa
-ovdje biramo:
· vrstu pisača (ako ga ne biramo, koristi se unaprijed zadani pisač u Windowsima) i njegova svojstva (npr. kakva je kvaliteta ispisa i kakav medij se koristi za ispis, npr. prozirna folija za laserski pisač)
· broj kopija
· raspon ispisa dokumenta:
· cijeli dokument
· samo neke stranice (prilagođeni ispis)
· pojedine stranice odvajamo zarezom, a ako je neprekinuti raspon znakom –
-primjer ispisa stranica: 1,4,5-7,9-11 //ispisujemo stranice 1,4,5,6,7,9,10,11
· trenutnu stranicu (to je stranica na kojoj nam se nalazi kursor)
· odabrane sadržaje (samo ono što smo označili u dokumentu)
· načine dovršavanja ispisa:
· jednostrani ili dvostrani ispis (ovisno da li pisač podržava dvostrani ispis)
· redoslijed ispisa kopija:
· grupiranje listova kopija u obliku knjige (npr. ako trebamo 5 kopija dokumenta od 10 stranica, ispisat će 5 puta sve stranice od 1 do 10 tako da su spremne za uvezivanje)
-to je uobičajeni način kod ispisa kopija
· negrupiranje listova kopija (svaku stranicu ispiše koliko nam treba kopija pa tako u prijašnjem primjeru redom dobivamo ispis 5 kopija stranice 1, potom 5 kopija stranice 2, itd.)
· umanjenje ispisa (koliko stranica dokumenta će biti ispisano na jednoj stranici papira)
· postavke stranice koje možemo i tu promijeniti prije ispisa (npr. veličina papira, usmjerenje, margine)
c) Zajednički koristi (engl. Share)
-ovo koristimo ako želimo olakšati da više osoba radi na istom dokumentu (npr. spremanjem u oblak)
d) Izvezi (engl. Export)
-biramo dodatne postavke formata za spremanje sadržaja (npr. XPS-a)
e) Korisnički račun (engl. Account)
-ovdje unosimo ključ proizvoda i aktiviramo Office
-ako program nema ispravan ključ ili nije aktiviran, radit će neko kraće vrijeme samo sa osnovnim mogućnostima, a onda prestati raditi
f) Povratne informacije (engl. Feedback)
-želimo li poboljšati iduću verziju Worda, možemo razvojnom timu poslati naše pohvale, primjedbe i prijedloge
g) Mogućnosti (engl. Options)
-ako želimo podesiti ponašanje Worda u skladu sa svojim željama, ovdje nam je na raspolaganju puno toga (npr. da li se ispisuje pozadina dokumenta)
5.1.5. Prikaz dokumenta
-prilikom unosa teksta unose se i neki znakovi koji u uobičajenom prikazu nisu vidljivi
-pomoću njih se npr. razdvajaju riječi, oblikuju odlomci i slično 
[image: ]-za prikaz tih znakova potrebno je kliknuti na odgovarajuću ikonu iz grupe Polazno>Odlomak
-naredba se zove Prikaži/Sakrij (engl. Show/Hide)
-uobičajeno ne prikazujemo nevidljive znakove, ali ponekad ih trebamo vidjeti (npr. da vidimo oznaku kraja sekcije)
-tri najčešća znaka oblikovanja su:
· razmak (pritisak na razmaknicu)
-prikazuje se znakom točkice ·
· početak i kraj odlomka (pritisak na tipku Enter)
-prikazuje se znakom  ¶
· tabulator (pritisak na tipku Tab)
-služi za stvaranje većeg razmaka u redu
[image: ]-prikazuje se znakom →
-program nudi nekoliko načina prikaza dokumenta klikom na Prikaz>Prikazi:
a) Način za čitanje (engl. Read Mode)
-ovakav prikaz olakšava nam čitanje gotovog dokumenta, ali nije pogodan za unos sadržaja
-da se olakša čitanje, ovaj način prikaza omogućava: 
· otvaranje navigacijskog okna (engl. Navigation Pane) za lakše snalaženje u tekstu
· prikaz komentara za pojašnjenje napisanoga
· mijenjanje širine stupca za lakše čitanje
· promjenu pozadine stranice (sepia, inverzno s crnom pozadinom) za manje umaranje očiju
· prikazivanje u stupcima radi lakšeg praćenja teksta (mada originalni tekst nije u stupcima)
· rastavljanje riječi u slogove (npr. A . na . li . zi . ra . ti umjesto Analizirati) radi lakšeg čitanja za osobe s poteškoćama čitanja (npr. mala djeca, starci, disleksičari)
· promjenu proreda za olakšanje čitanja slično prijašnjoj mogućnosti
· čitanje označenoga teksta (podržava i hrvatski jezik) za slabovidne osobe
-iz ovoga prikaza izlazimo odabirom prve naredbe u stupcu (Uredi dokument, engl. Edit document)
b) Raspored za ispis (engl. Print Layout)
-ovo je uobičajen (i najbolji) način prikaza jer nam prikazuje točan izgled teksta, grafike i ostalih dijelova dokumenta (npr. margine, zaglavlja i sl.) kako će biti ispisani na papiru
-koristimo ga da bismo upisivali, uređivali i oblikovali tekst
[image: ]-osim samog pisanja, ovaj prikaz koristan je za uređivanje dodatnih elemenata dokumenta (npr. zaglavlja i podnožja dokumenta, za podešavanje margina, kod rada sa stupcima teksta, pri unosu crteža i fotografija u tekst i sl.)

c) Raspored za web (engl. Web Layout)
-ovaj prikaz koristan je kod stvaranja web-stranica jer se cijeli tekst vidi na ekranu prikazan bez suvišnih grafičkih elemenata (npr. pozadine stranice) dok su ostali grafički objekti (npr. slike) prikazani drukčije smješteni
[image: ]-rijetko se koristi

d) Struktura (engl. Outline)
-koristimo ga kad želimo vidjeti strukturu (građu) dokumenta te za premještanje, kopiranje i reorganizaciju teksta povlačenjem naslova
[image: ]-ne koristi se često

e) Skica (engl. Draft)
-u njemu se prikazuje oblikovanje teksta, ali pojednostavljeni je prikaz stranica bez grafičkih objekata (npr. pozadine, slika, crteža)
[image: ]-vrlo rijetko se upotrebljava
[image: ][image: ]-na dnu dokumenta možemo brzo promijeniti način prikaza (Način za čitanje, Raspored za ispis, Raspored za web) odabirom odgovarajuće ikone
[image: ]-prikaz dokumenta na ekranu prilagođava se veličinom (povećava ili smanjuje) naredbama iz grupe  Prikaz>Zumiraj (engl. View>Zoom) te izborom iznosa povećanja u postocima (engl. Percent)
[image: ]-osim u postocima, dade se izabrati prikaz:
a) Jedna stranica (engl. One Page)
-stranica se prilagodi tako da je čitava vidljiva na ekranu
-nije preporučljivo za promjene u dokumentu (tekst je presitan za označavanje), ali se vide odnosi teksta i ostalih elemenata (npr. tablica i slika)
b) [image: ]Veći broj stranica (engl. Multiple Pages)
-vidi se nekoliko umanjenih stranica
-pogodno je za završno pregledavanje gotovoga dokumenta
c) Širina stranice (engl. Page Width)
[image: ]-stranica se tako prilagodi da se vidi cijela širina dokumenta, uključujući i margine
-uobičajeno se koristi za unos sadržaja jer je lakše označavanje zbog uvećanog prikaza teksta i objekata
[image: ]-opcije zumiranja možemo brže dobiti izborom ikone zumiranja u donjem desnom kutu dokumenta
[image: ][image: ]-ukoliko smo neku radnju krivo napravili u Wordu možemo poništiti promjenu klikom lijevom tipkom na ikonu Poništi (engl. Undo) u traci za brzo pokretanje (strelica svinuta ulijevo) 
[image: ][image: ]-možemo poništiti i nekoliko zadnjih uzastopnih promjena (bez preskakanja pojedinih, dakle sve po redu) klikom na sitnu bijelu strelicu pokraj ikone poništi i odabirom naredbi koje želimo poništiti
-želimo li opozvanu promjenu ponovo vratiti, aktivirat ćemo ikonu Vrati poništeno (engl. Redo) (strelica svinuta udesno)
[image: ][image: ]-naredbe na traci za brzo pokretanje možemo birati kao i mjesto njezina prikaza klikom na sitni trokutić na njenom desnom kraju
-naredbe označene kvačicom vidljive su na traci, one bez nisu
-možemo birati i bilo koje naredbe klikom na Više naredbi… (engl. More commands) i odabirom željene naredbe iz neke grupe naredbi (isto kao i aktiviranjem Datoteka>Mogućnosti>Alatna traka za brzi pristup)
-traka za brzi pristup logično je smještena na početak naslovne trake dokumenta, ali se izborom naredbe Prikaži ispod vrpce (engl. Show under ribbon) može spustiti ispod otvorene vrpce s naredbama
[image: ]-time ništa ne dobivamo osim smanjenja područja za prikaz dokumenta pa je to neželjena mogućnost koju vraćamo natrag klikom na trokutić i naredbom Prikaži iznad vrpce (engl. Show over ribbon)
-na kartici Prikaz možemo prikazati ili isključiti:
a) Ravnalo (engl. Ruler)
[image: ]-uobičajeno je vidljivo, koristimo ga da izmjerimo udaljenosti objekata i sl. (npr. izmjerimo širinu stupca tablice u mm ili cm)
b) [image: ]Crte rešetke (engl. Grid)
-ako nam je pozadina stranice jednobojna (npr. žuta), možemo vidjeti sitne kvadratiće (npr. kao u bilježnici iz matematike) koji nam mogu pomoći da lakše poravnamo pojedine objekte u dokumentu (npr. slike jednu ispod druge)
c) Navigacijsko okno (engl. Navigation pane)
-u ovom oknu s lijeve strane glavnog prozora možemo vidjeti rezultate pretraživanja teksta ili nekih drugih elemenata (npr. slika, jednadžbi) i brzo se kretati po označenim rezultatima
-traženi rezultati mogu se birati u:
· naslovima
· stranicama
· tekstu
-pronađeni rezultati se u tekstu u glavnom prozoru ističu markiranjem u žutu boju
[image: ]-ispiše nam se ukupni broj nađenih rezultata pa se strelicom gore ili dolje krećemo od jednog do drugog rezultata

-kada istodobno radimo sa dva ili više dokumenta možemo ubrzati rad prikazom otvorenih prozora u više prozora
-najčešće se koristi prikaz samo dva prozora jer su inače prozori premaleni za ugodan rad
-rad sa više prozora nam je koristan kada moramo istodobno vidjeti prikaz više dokumenata, različitih ili istih (npr. nešto moramo kopirati iz jednoga dokumenta s puno stranica i prebacivati u drugi i sl.)
-naredbe za rad s prozorima dostupne su odabirom grupe Prikaz>Prozor (engl. View>Window)
-možemo upotrijebiti ove naredbe:
a) [image: ]Novi prozor
-stvaramo novi prozor istog dokumenta 
-svaki prozor dobiva posebnu oznaku, tj. redni broj prozora u naslovnoj traci (odmah iza nastavka datoteke odvojene dvotočkom, npr. docx:2)
b) Razmještaj svih elemenata
-ovime se prikažu svi otvoreni prozori jedan ispod drugoga pri čemu na graničnim horizontalnim linijama možemo definirati visinu svakoga od njih (povlačenjem dvostruke strelice za promjenu dimenzija prozora gore-dolje)
-ako neki prozor ne želimo vidjeti u razmještaju, spustimo ga gumbom za minimiziranje ili zatvorimo
[image: ]
c) Podjela
-isti dokument možemo prikazati u dva prozora jedan ispod drugoga pri čemu sadržaj u svakom od njih možemo neovisno pomicati
-ova naredba umeće granicu podjele dokumenta na dva prozora počevši od trenutnog položaja kursora
-u svakom prozoru vidljiv je sadržaj cijelog dokumenta
[image: ]-kao i u prijašnjem slučaju, na graničnim horizontalnim linijama možemo definirati visinu svakoga od njih (povlačenjem dvostruke strelice za promjenu dimenzija prozora gore-dolje)
-ovo je korisna naredba kada radimo s većim brojem stranica u dokumentu (npr. sa stranice 3 moramo kopirati pojedine slike na stranicu 79) pa se ne moramo stalno kretati naprijed-natrag mišem i klizačima
d) Usporedni prikaz
[image: ]-kada smo razmjestili prozore naredbom Razmještaj svih elemenata, ovom možemo odrediti da li će ostati prikazani jedan ispod drugoga ili jedan pokraj drugoga
e) Sinkronizirano pomicanje
[image: ]-pri odabiru Usporednog prikaza odlučujemo da li ćemo sadržaj svakoga prozora pomicati zasebno ili će se pomicanjem jednoga na isti način pomicati sadržaj drugoga 
-pritom ne moramo biti na istom mjestu u oba prozora (npr. u prvom prozoru smo kursor postavili na 3. stranicu, a u drugom na 8.)
-ovo je korisno ako moramo negdje raditi pomake na sadržaju za određeni broj stranica
f) Vrati izvorni položaj prozora
-kada je uključen Usporedni prikaz, a pomicali smo sadržaj nekog od ta dva prozora, ovime položaj kursora u tom prozoru vraćamo na onaj u trenutku uključenja Usporednog prikaza
g) [image: ]Promjena prozora
-ovdje klikom biramo koji prozor je trenutno vidljiv (onaj s kvačicom)

[image: ][image: ]-na naslovnoj vrpci još možemo odabrati način prikaza aktivne kartice, vrpce i naredbi na njima klikom na simbol kvadratića sa strelicom prema gore pokraj gumba za minimiziranje prozora u gornjem lijevom kutu prozora 
-na raspolaganju su nam mogućnosti prikaza:
a) Automatski sakrij vrpcu (engl. Auto hide ribbon) 
-vrpca sa naredbama nije vidljiva dok mišem ne dođemo na sam vrh prozora i kliknemo lijevom tipkom na plavu vrpcu koja se pojavila
-ovakav prikaz koristan je ako nam je bitan čim veći dio prikazanoga sadržaja (npr. teksta), a ne ikone naredbi jer ćemo se koristiti mišem ili prečicama (npr. kod uređivanja teksta za kopiranje označenoga teksta koristimo prečicu Ctrl + C)
-za ostale operacije bitan nam je prikaz ikona naredbi pa nam je ovakav prikaz nepraktičan
[image: ]-isključujemo ga ponovnim klikom na ikonu kvadratića sa strelicom i odabirom drugih opcija
b) Pokaži kartice (engl. Show tabs)
-ovdje je vidljiva samo uska traka s prikazom kartica, a vrpcu s naredbama vidimo tek kada kliknemo karticu
-ovo je kompromis između prve i zadnje mogućnosti prikaza pa dobivamo veći dio radnog područja, a naredbe se mogu lako prikazati
[image: ]-ipak, za ozbiljniji rad s općim sadržajem je nepraktično
c) Pokaži kartice i naredbe (engl. Show tabs and commands)
[image: ]-ovo je standardna postavka gdje vidimo sve kartice i naredbe u vrpci, ali nam je radno područje najmanje

5.2. Oblikovanje teksta
-oblikovanje teksta uključuje promjenu grafičkog izgleda teksta
-prije nego počnemo mijenjati izgled teksta, obavimo sve promjene u sadržaju teksta
-promjene sadržaja teksta zovu se uređivanjem (engl. editing)
5.2.1. Upotreba tipkovnice
-tipkovnicu koristimo za unos teksta i aktiviranje određenih naredbi
[image: ][image: ]-za pisanje velikog slova (jednog ili nekoliko njih) najbolje je držati pritisnutu jednu od dvije tipke Shift (vidi izgled tipke) 
[image: ]-ukoliko je u to vrijeme bila aktivirana tipka Caps Lock (svijetli LED indikator), tada tipkanje slova uz pritisnutu tipku Shift daje opet mala slova
[image: ]-tipka Shift, osim za pisanje velikih slova, služi i za pisanje posebnih znakova na tipkama s više znakova (npr. tipka s brojem 7 ispisuje broj 7 bez Shift tipke, a s njom desno nagnutu kosu crtu /)
-aktivirana tipka Caps Lock (svijetli LED indikator) služi za duže pisanje velikih slova (npr. naslovi) – vidi prikaz tipke
-idući pritisak na istu tipku deaktivira je
[image: ]-uključenost ili neuključenost tipke Caps Lock ne utječe na tipke koje nisu slova (npr. tipka 9 uvijek će ispisivati 9, a ne zagradu)
-ukoliko unosimo puno brojki, poželjno je koristiti tipke iz numeričkog dijela tipkovnice koje uključujemo pritiskom na tipku Num Lock (svijetli LED indikator) – vidi sliku tipke
-u tom slučaju možemo se služiti i brojkama, dok se bez uključenosti te tipke možemo služiti preostalim simbolima na tim tipkama (npr. tipka / iz numeričkog dijela uvijek će ispisivati kosu crtu, neovisno o tipki Num Lock, dok će pritisak na tipku 3 pg dn ispisati 3 (uključeni Num Lock) ili pomaknuti sadržaj za sadržaj prozora nadolje – neuključena tipka Num Lock)
-želimo li napraviti razmak među riječima ili znakovima, upotrijebit ćemo pritisak na najveću tipku tipkovnice – razmaknicu (engl. space key)
-praznine (razmake) treba koristiti racionalno (pametno), jer njihova prevelika upotreba otežava oblikovanje teksta (npr. uvlačenje za početak odlomka (paragrafa) može se obaviti i bez razmaka)
-tipku Enter upotrebljavamo za početak i kraj novog odlomka ili za dobivanje praznog reda (dodatni pritisak na Enter nakon kraja odlomka)
-nije poželjno koristiti tipku Enter za dodavanje praznih redova radi prelaza na iduću stranu jer se onda cijeli sadržaj od trenutnog odlomka do kraja dokumenta pomiče
-za prijelaz na novu stranicu uobičajeno se koristi Prijelom stranice (engl. Page Break)
[image: ][image: ]-ako želimo napraviti prijelaz u novi red, ali unutar istog odlomka, koristimo kombinaciju tipki Shift i Enter
-postoje dvije tipke Enter, veća na alfanumeričkom dijelu tipkovnice (vidi sliku) i manja na numeričkom dijelu
[image: ][image: ]-brisanje jednog znaka (ili dijela označenog teksta) obavlja se tipkama Backspace (briše znak lijevo od kursora) ili Delete (briše znak desno od kursora) 
-grupa tipki za kretanje po tekstu služi nam za pomak kursora:
a) na početak retka (Home)
b) na kraj retka (End)
c) jednu stranicu prema gore, tj. prema početku dokumenta (Page Up ili PgUp)
d) jednu stranicu prema dolje, tj. prema kraju dokumenta (Page Down ili PgDn)
[image: ]-pomicati po tekstu kursor za jedno mjesto gore, dolje, lijevo ili desno možemo upotrebom kursorskih tipki (strelica)
-tipke Alt i Ctrl služe za proširenje funkcija ostalih tipki (npr. Ctrl + V kopira označeni dio teksta u privremenu memoriju (engl. Clipboard), a Alt + V ispisuje znak @)
-tipka Insert (Ubaci) ovdje nema funkciju jer je u početnim postavkama podešeno da se koristi način rada (engl. mode) s pomicanjem ostatka teksta udesno (Insert način rada)
-u nekim prijašnjim verzijama bila je mogućnost da se tom tipkom prelazi s Insert načina u tzv. Overwrite (Prepiši) način rada u kojem se tekst desno od kursora ne pomiče, već se briše znak po znak unosom novih znakova
-to je bilo problematično jer se često događalo slučajno gašenje Insert načina rada nehotimičnim pritiskom na Insert tipku, pri čemu se dio teksta desno od kursora počeo brisati
-zbog toga se je Overwrite način onemogućen, ali se može aktivirati u postavkama (Datoteka->Mogućnosti)
5.2.2. Uređivanje teksta
-u uređivanje teksta spada: 
a) označavanje (engl. selecting)
b) dodavanje (engl. inserting, adding)
c) brisanje (engl. deleting)
d) kopiranje/lijepljenje (engl. copying/pasting, pomoću međuspremnika (engl. clipboard))
e) premještanje (engl. moving)
f) pretraživanje i zamjenjivanje (engl. searching, replacing)

5.2.2.1. Označavanje teksta
-označavanjem odabiremo dio teksta za izvođenje određenih radnji (npr. kopiranje)
-označavati tekst možemo mišem i/ili tipkama
-označeni tekst je nakon označavanja prikazan uokviren sivom bojom
-obično je jednostavnije i brže označiti mišem (eventualno uz dodatak pritiska na neku tipku)
-u idućoj tablici prikazani su načini označavanja teksta mišem
	bilo koja količina teksta u nizu
	-pokazivač miša klikne se na željeni početak teksta za označavanje i uz pritisak lijeve tipke miš se pomiče koliko želimo u bilo kojem smjeru
-uobičajeno ga koristimo ako ne označavamo puno teksta (npr. pola stranice, a ne 25 stranica)

	jedna riječ
	-dvoklik lijevom tipkom na tu riječ
-uz riječ se označava i razmak do iduće riječi što može biti neželjeno za neke operacije (npr. za markiranje)

	jedna rečenica
	-držanje tipke Ctrl i klik bilo gdje u rečenici

	više riječi bilo gdje u tekstu
	-označi se prva riječ i dalje se uz držanje tipke Ctrl dvoklikom odabiru iduće riječi
-istim načinom može se dodavati i manje ili veće dijelove teksta (npr. dijelove riječi ili dijelove rečenica)

	jedan redak
	-pokazivač miša postavimo malo pred početak retka (na margini) tako da promijeni oblik u strelicu, a potom jedanput kliknemo lijevom tipkom

	više uzastopnih redaka
	-označimo jedan redak i uz držanje lijeve tipke pomičemo pokazivač gore ili dolje
-to je pogodno ako označavamo malo redaka (npr. 15)
-ako trebamo označiti puno uzastopnih redaka (npr. 350), onda je jednostavnije označiti prvi klikom ispred njega i potom držati tipku Shift te nakon pomicanja sadržaja mišem na vertikalnim klizačima kliknemo zadnji redak za označavanje

	više redaka koji nisu nužno u nizu
	-označimo prvi redak i uz držanje tipke Ctrl označavamo ostale retke

	jedan odlomak
	-dvoklik lijevom tipkom ispred bilo kojega retka odlomka

	cijeli dokument
	-na raspolaganju su nam tri načina:
· troklik pred bilo kojim retkom teksta (nepraktično jer treba dosta brzo kliknuti triput)
· držanje tipke Ctrl i klik bilo gdje na lijevoj margini (bolji način od prijašnjega)
· prečicom Ctrl i A (najbolje i najbrže označavanje, a i podsjeća nas na istu prečicu kod označavanja datoteka i mapa)

	odustajanje od odabira
	klik mišem bilo gdje u dokumentu (ne na marginama)


-manji dio teksta možemo označiti samo tipkama tako da kursorskim tipkama (strelicama) dođemo na željeni dio teksta i onda uz pritisnutu tipku Shift pomicanjem strelicama dodajemo pojedine znakove ili retke u označeni dio teksta
[image: ][image: ][image: ]-primjeri označavanja teksta:
[image: ][image: ][image: ]
[image: ][image: ]
5.2.2.2. Dodavanje teksta
[image: ]-da bismo u postojeći tekst dodali novi tekst, kliknemo lijevom tipkom da kursor premjestimo na željeni položaj, a potom unosimo željeni sadržaj tipkama

5.2.2.3. Brisanje teksta
-označeni tekst brišemo:
· pritiskom na Backspace ili Delete tipku (brže i bolje) 
· desnim klikom na označeni tekst i odabirom naredbe Izreži (engl. Cut, sporije i lošije)
[image: ]-ovo je u stvari pripremni korak za premještanje teksta, ali tekst je ipak nestao

5.2.2.4. Kopiranje/lijepljenje teksta pomoću međuspremnika
[image: ]-označeni tekst možemo prekopirati u privremenu memoriju (međuspremnik) i potom ga zalijepiti bilo koliko puta želimo na bilo kojem mjestu u dokumentu
-kopiramo desnim klikom na označeni dio i odabirom naredbe Kopiraj ili brže prečicom Ctrl + C 
-tekst lijepimo na željeni položaj (definiran kursorom) desnim klikom odabirom naredbe Mogućnosti lijepljenja i izborom željenog načina lijepljenja
[image: ][image: ][image: ]-isto možemo brže napraviti prečicom Ctrl + V, a onda naknadno promijeniti način lijepljenja klikom na pravokutnik s natpisom Ctrl koji je aktivan nakon lijepljenja (ako nismo potom napravili neke nove radnje) 
-na raspolaganju su nam ovi načini lijepljenja: 
· Koristi odredišnu temu ili Zadrži izvorišno oblikovanje
[image: ]-kopirani sadržaj se pojavi u onom obliku kakav je bio na mjestu kopiranja (npr. ista veličina i boja fonta)
· Spoji oblikovanje
-kopirani sadržaj se oblikuje na isti način kako je oblikovan tekst na trenutnom položaju kursora
[image: ]-pritom se mijenjaju postavke oblikovanja (npr. promijeni se vrsta i veličina fonta, boja fonta i markera i sl.) 
· Slika
-kopirani dio se pretvori u sliku u rasponu od lijeve do desne margine
-takav tekst se ne da mijenjati, a može se pomicati i mijenjati postavke kao slici
-ovaj način lijepljenja se rijetko koristi
· [image: ]Zadrži samo tekst
-ovim lijepljenjem odbacuju se svi ostali elementi oblikovanja i objekti (npr. marker, linkovi), a tekst svojstvima postaje jednak onom na položaju kursora (npr. vrsta i veličina fonta, boja fonta)
-često se koristi kada u dokument ubacujemo tekst iz drugih izvora (npr. web stranica) koji sadrži neželjena oblikovanja i/ili objekte
-želimo li kopirati i lijepiti više stavki (označenih dijelova teksta) nezavisno jedne od drugih, možemo korisiti alat međuspremnika u punom obliku
-on nam omogućava stalno pamćenje (i lijepljenje) do 24 nezavisnih stavki (dijelova teksta ili slika) 
-međuspremnik pokrećemo klikom na pokretač dijaloškog okvira Međuspremnik na kartici Polazno
[image: ]-svako kopiranje ubacuje tekst u međuspremnik (vidi se prikazan dio kopiranog teksta bez prikaza oblikovanja, ali pri lijepljenju se doda cijeli tekst sa svim oblikovanjima)
-pritom se zadnji kopirani tekst stavlja na vrh popisa, a prvi kopirani na dno
-ako smo iskoristili svih 24 mjesta za pamćenje i ponovo nešto kopiramo, prvi kopirani sadržaj (na dnu popisa) se odbacuje i sve se pomiče na niže za jedno mjesto (FIFO princip, engl. First In, First Out)
-to se ponavlja za sva iduća kopiranja
[image: ]-svaku stavku u međuspremniku možemo klikom na nju zalijepiti bilo koliko puta ili obrisati s popisa (klik na padajući izbornik s naredbama Zalijepi i Izbriši) 
-osim toga, možemo poretkom kopiranja zalijepiti sve stavke na željeno mjesto (gumb Zalijepi sve na vrhu popisa) ili sve obrisati iz međuspremnika (gumb Očisti sve)
-međuspremnik je koristan ukoliko trebamo veći broj dijelova teksta s jednoga mjesta (ili dokumenta) staviti na neko drugo mjesto ili dokument (npr. iz tablice na 100.-toj stranici moramo prekopirati imena učenika iz razreda u drugu tablicu na 3.-oj stranici)
-upotrebom međuspremnika smanjujemo potrebu za stalnim pomicanjem s jednog mjesta na drugu unutar dokumenta
-nedostatak upotrebe međuspremnika je sužavanje radnog područja s lijeve strane, a umjesto međuspremnika možemo raditi s više prozora

[image: ]5.2.2.5. Premještanje teksta
-za premještanje teksta kliknemo desnom tipkom na označeni dio i odaberemo naredbu Izreži (engl. Cut)  ili brže prečicom Ctrl + X
-nakon te naredbe označeni dio nestaje i možemo ga zalijepiti na prije opisane načine (Ctrl + V ili odabir Mogućnosti lijepljenja)
[image: ]-ako premještamo manji dio teksta unutar istog prozora (bez potrebe za puno pomicanja sadržaja), možemo na označeni dio teksta nakon označavanja kliknuti i držati lijevu tipku uz pomicanje miša
-pojavljuje se podebljani tekstni kursor koji definira početnu poziciju premještenog teksta nakon otpuštanja tipke miša

5.2.2.6. Pretraživanje i zamjenjivanje teksta
[image: ]-kada imamo puno teksta, teško nam je pronaći željeni dio
-da nam se olakša taj zadatak, koristimo naredbu Traženje (engl. Find, krajnje desna grupa naredbi Uređivanje na kartici Polazno) 
-omogućava nam pretraživanje po naslovima, stranicama i prikaz rezultata
[image: ]-taj dio smo obradili u uvodnom dijelu
[image: ]-želimo li detaljnije pretraživanje, tada na istoj naredbi Traženje kliknemo na crni trokutić s njezine desne strane i odaberemo naredbu Dodatno traženje
[image: ]-nakon toga pojavi se prozor Traženje i zamjena u kojem su nam dostupne kartice Traži, Zamijeni i Idi na
-odabirom kartice Traži otvara se prozor naprednog pretraživanja
-u polje Traži ovo upišemo traženi pojam (dio riječi, riječ ili više njih, npr. riječ tekst)
-nakon toga možemo se koristiti padajućim izbornicima ispod okvira u koji smo unijeli tekst:
a) Više >> (ili << Manje ako je izbornik bio aktiviran)
-omogućava detaljnije prilagodbe za pretraživanje (npr. razlikovanje velikih i malih slova)
-nudi Mogućnosti pretraživanja:
· [image: ]Traži
· Sve
-pretražuje se cijeli dokument od početka do kraja (početna postavka)
· Dolje
-tekst se pretražuje od trenutnog položaja kursora do kraja dokumenta
· Gore
-tekst se pretražuje od trenutnog položaja kursora prema početku dokumenta
· Razlikuj velika i mala slova
-u pretrazi razlikuju se velika i mala slova (npr. tekst Ana nećemo naći ako se razlikuju velika i mala slova, a u pretrazi smo napisali ana)
-ovo je korisno kada smo sigurni da riječ počinje velikim slovom (npr. na početku riječi ili kod osobnih pojmova poput imena i prezimena)
· Traži samo cijele riječi
-ovo koristimo kada ne želimo da traženi pojam bude dio neke riječi, već cijela riječ
-primjer: uz ovu opciju pri traženju teksta film, program nam ne vraća rezultat ako u tekstu postoji riječ filmski
· Koristi zamjenske znakove
-može se zadati da uz vidljive znakove traži i neke nevidljive (npr. tražimo gdje je bio pritisnut Enter za stvaranje novog odjeljka) pomoću njihove znakovne zamjene (npr. kombinacija ^p je oznaka za kraj odlomka, tj. pritisnuti Enter)
-stoga, ako u okvir za traženje napišemo film.^p, onda tražimo dio teksta u kojem odlomak završava tekstom film.
· Zvuči kao (engleski)
-ovo je upotrebljivo samo za tekst pisan na engleskom pri čemu nalazi riječi koje se izgovaraju slično napisanom pojmu (npr. nice i night)
· Traži sve oblike riječi (engleski)
-ovo je upotrebljivo samo za tekst pisan na engleskom pri čemu nalazi riječi koje su izvedenice napisanog pojma (npr. nice i nicely)
· Podudaranje prefiksa
-traži riječi koje u sebi sadrže zadani tekst, ali i neke znakove ispred njega (npr. za traženu riječ opis naći će kao rezultat i popis)
· Podudaranje sufiksa
-traži riječi koje u sebi sadrže zadani tekst, ali i neke znakove iza njega (npr. za traženu riječ lijep naći će kao rezultat i lijepa ili lijepo)
· Zanemari znakove interpunkcije
-kod pretraživanja znakove interpunkcije (npr. : ; , . -) ne razmatra
-primjer: za traženu riječ lopta kao rezultat će vratiti i lopta. ili lopta,
· Zanemari znakove razmaka
-kod pretraživanja znakove razmaka ne razmatra
-primjer: za traženu riječ parada kao rezultat će vratiti i para da
-na dnu je okvir Traži s tri padajuća izbornika
· [image: ]Oblik
· Font
· Odlomak
· Tabulatori
· Jezik
· Okvir
· Stil
· Istakni
-sve ove stavke koristimo kada želimo pronaći tekst s dodatnim detaljima oblikovanja (npr. tražimo tekst lopta koji je pisan fontom Arial Podebljano veličine 16 i crvene boje)
[image: ][image: ]-ovo se rijetko koristi, ali se može koristiti i kod zamjenjivanja da se pronađeni tekst oblikuje na drugi način (npr. svaku traženu riječ škola će napisati fontom Verdana veličine 24 i plave boje)
· Posebno
-sadrži niz stavki koje se odnose na traženje nekih nevidljivih znakova (npr. oznaku kraja odlomka, tabulator) u tekstu
-time možemo pobrisati sve slučajne višestruke razmake u tekstu (mijenjamo dva razmaka jednim dokle se nađe nešto za zamjenu) ili maknuti krajeve odlomka (npr. ako je netko stalno radio prijelaz na početak reda pomoću Entera)
· [image: ]Bez oblikovanja
-ako smo postavili neke opcije iz padajućeg izbornika Oblik (npr. tražimo riječ pisanu fontom Arial veličine 16), time se one poništavaju za iduća pretraživanja
b) [image: ][image: ]Isticanje pri čitanju
Istakni sve
[image: ]-ovime se privremeno istakne traženi dio teksta markiranjem (Istakni sve) ili se privremeno isticanje poništi (Poništi isticanje)
c) [image: ]Pronađi u
Glavni dokument
-ovdje biramo da se pretražuje tekst dokumenta (unaprijed zadano)
Zaglavlja i podnožja
[image: ]-možemo pretražiti samo sadržaj zaglavlja ili podnožja (npr. traženje naziva poglavlja ili broja stranice), ali vrlo rijetko nam to treba
d) Traži sljedeće
[image: ]-klikom na ovaj gumb program nas pomiče s jednoga rezultata pretraživanja na drugi i markira pronađene dijelove teksta
e) Odustani
-ovom naredbom zatvara se prozor pretraživanja
-odabirom kartice Zamijeni (engl. Replace) možemo dio teksta zamijeniti novim sadržajem
-prozor ima skoro sve jednako kao i prozor Traži, samo su ove razlike: 
· [image: ]postoji dodatni okvir za unos teksta (Zamijeni ovim) u koji unosimo sadržaj za zamjenu traženog teksta
· umjesto gumbi Isticanje pri čitanju i Pronađi u nalaze se gumbi:
· Zamijeni
-ovim gumbom mijenja se pronađeni dio (prikazan markirano) zadanim i to se odvija do kraja (ili početka) dokumenta
-pritom se tekst stalno pomiče tako da vidimo dio koji se nudi za zamjenu
· Zamijeni sve
-time se svaki pronađeni dio u tekstu mijenja zadanim (sve do kraja (ili početka) datoteke)
-odabirom kartice Idi (engl. Go to) dolazimo na dio za lakše i brže kretanje po dokumentu
-čine ga okviri:
· Idi na:
[image: ]-ovdje biramo na koji izdvojeni dio dokumenta se želimo pozicionirati (npr. na određenu stranicu (najčešće), redak, tablicu, sliku, naslov i sl.) 
· Upiši broj stranice:
-ova naredba aktivna je samo ako smo odabrali kretanje po stranicama (početna postavka, a uglavnom ju koristimo)
-ako smo odabrali kretanje po drugoj vrsti sadržaja, naziv naredbe se tome prilagođava (npr. upišite broj tablice kod odabira pretraživanja tablica)
-ovdje možemo zadati željeni broj na dva načina:
· točan broj stranice
-prikaz sadržaja i kursor se pomiču na početak zadane stranice (npr. 16)
· relativni pomak u odnosu na trenutnu stranicu (stranica na kojoj nam titra tekstni kursor)
-pomak u odnosu na trenutnu stranicu može biti prema:
· kraju dokumenta (znak + uz broj stranica pomaka, npr. +6 znači da se u dokumentu pomičemo za 6 stranica prema kraju dokumenta u odnosu na trenutnu stranicu)
· početku dokumenta (znak - uz broj stranica pomaka, npr. -3 znači da se u dokumentu pomičemo za 3 stranice prema početku dokumenta u odnosu na trenutnu stranicu)

· Prethodno
-prebacuje nas na prijašnju stavku iste vrste (npr. stranice ili slike)
· Sljedeće
-prebacuje nas na iduću stavku iste vrste (npr. stranice ili slike)
· Zatvori
[bookmark: _GoBack]-zatvaramo prozor Traženje i zamjena
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-ovo je uobicajen (i najbolji) nadin prikaza jer nam prikazuje toéan izgled teksta, grafike i ostalih dijelova
dokumenta (margine, zaglavlja i sl.) kako ée biti ispisani na papiru

-koristimo ga da bismo upisivali, uredivali i oblikovali tekst

-osim samog pisanja, ovaj prikaz koristan je za uredivanje zaglavlja i podnozja dokumenta, za podeSavanje
margina, kod rada sa stupcima teksta, pri unosu crteza i fotografija u tekst i sl.

Raspored za web (engl. Web Layout)
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5.1.1. Uvod u obradu teksta
-obrada teksta omogucena je pojavom programa koje zovemo obradivaéi teksta (tekstni procesori, engl. text processor)
-najéesce koristeni takav program je Microsoft Word, krace — MS Word ili samo — Word

-on je dio programskog paketa Microsoft Office - krace MS Office ili samo — Office

-mi obradujemo Word 2019 iz paketa Office 2019

-Word sluzi za slozeniji rad s tekstom i ostalim objektima (obrada teksta, engl. text processing) dok za jednostavne preinake na Gistom tekstu siuze uredivaci teksta (editori teksta, engl. text editor, npr. Blok za pisanje)
-sadrzaj stvoren u Wordu mozemo spremiti u vise raznih vrsta datoteka, a takvu datoteku zovemo dokumentom (engl. document)
-sufiksi tih datoteka su:

o>
n -ovo je dokument spremljen u uobi¢ajenom obliku
-on podrzava sve naredbe i objekte dostupne u Wordu
L. -ako nita ne Zelimo mijenjati, Word automatski sprema sadrzaj u taj format
W= > dog
-to je dokument spremljen u starijim verzijama Worda, do verzije 2003
-stariji format dokumenta ne podrzava direktno (radi se pretvorba) sve naredbe i objekte dostupne u Wordu pa program &esto pri spremanju iz novoga u stari oblik dokumenta traZi pristanak korisnika za potrebne
pretvorbe

-neki slozeniji objekti ne mogu se sprel iz novijega formata u stari

-koristimo ga ukoliko netko nema noviju verziju Worda ili ne Zelimo promijeniti izgled dokumenta spremljenog u starom formatu datoteke

-ukoliko otvaramo stariji format, Word trazi da kliknemo gumb koji ce omogucgiti preinake u tekstu
> pdf

-u nekoliko zadnjih verzija podrzano je spremanje u ovaj univerzalni format za razmjenu datoteka

-pretvaranje u ovaj oblik koristimo ako Zelimo poslati nekome dokument, a on ne koristi Word ili prije ispisa na veéim formatima (npr. Zelimo ispisati plakat formata A1)

-mozemo i otvoriti postojecu PDF datoteku za uredivanje sadrzaja, ali pritom ju prvo moramo pretvoriti u docx format

-pri tom pretvaranju esto se dogodi da Word ne zna ispravno prepoznati slozeniji dio sadrzaja (npr. ) pa te dijelove pretvori u sliku ¢iji sadrzaj ne mozemo uredivati

-u tom slu¢aju neprepoznate dijelove datoteke moramo ruéno unijeti
> xml

-ovo je format u obliku web stanice
etko ga upotrebljavamo, osim za dodavanje sadrzaja na web stranice

> txt
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-Cak i slucaju rugenja Worda cesto Word uspije spremiti promjene, ali datoteka nema ispravni naziv
-tada ovom naredbom vraéamo takvu datoteku u Zeljeno stanje
-u kartici Datoteka jo$ postoje naredbe:

a) Informacije (engl. Info)

-ovom naredbom dobijemo detaljne podatke o dokumentu i njegovu statistiku (npr. kako dugo je
radeno na njemu, koliko je strana i koliko znakova i sl.)

-mozemo kliknuti i jedan od tri gumba:

» Zastiti dokument (engl. Protect Document)

-ovdje zadajemo kakva prava na izmjene u dokumentu ima netko kome posaljemo
datoteku

-uobicajeno ima sve ovlasti, ali mozemo ih i ograni
ispisivati, ne i mijenjati sadrzaj ili oblikovanja)

(npr. da moze samo Citati i

-da netko nepozvan ne bi znao sadrzaj datoteke, ovdje ju mozemo zastiti i lozinkom koju
¢e onda trebati unijeti za svako otvaranje datoteke

» Provjeri ima li problema (engl. Check for Issues)

-ovom naredbom provjeravamo da li:
su u dokumentu vidljivi neki osobni podaci (npr. da li se vidi ime autora dokumenta)

osobe s poteSko¢ama imaju problema pri pregledavanju sadrzaja (npr. da li ga lako moze
koristiti slabovidna osoba)

je dokument kompatibilan sa nekim starijim verzilama (npr. da li ¢e se pri spremanju u
neku verziju izgubiti neki dio sadrzaja)
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Videozapis je uginkovit natin da argumentirate svoje stajaliste. Kad Kiiknete Videozapis s interneta,

moete zalijepiti ugradeni kod za videozapis koji Zelite dodati. MoZete unijeti Kljuznu rijet koju éete

pretrasivati na internetu za
dokumentu. Da bi dokument
zaglavlja, podnofja, naslovne
nadopunjavaju. Na primjer,
zaglavie i boénu traku.

Kiiknite Umetanje, a zatim
Teme i stilovi i omoguéuju da
odaberete novu temu, slike,

' videozapis  koj

najbolje | odgovara vasem
izgledao  profesionalno,  Word nudi  dizajne
stranice i tekstnog okvira koji se medusobno
motete dodati odgovarajuéu naslovnu- stranicu,

odaberite Zeljene elemente iz razli¢itih galerija.
dokument ostane uskladen. Kada kliknete Dizajn i
grafikoni i SmartArt grafika promijenit ¢e se u

skladu s novom temom, Kada primijenite stilove, naslovi ¢e se promijeniti u skladu 5 novom temaom.
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dijelove dokumenata i usredototiti se na Zeljeni tekst. Ako morate prekinuti ¢itanje prije nego dodete
do kraja, Word pamti gdje ste stali, &ak i na drugom uredaiju.

Videozapis je utinkovit natin da argumentirate svoje stajaliste. Kad kliknete Videozapis s interneta,
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